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Chapter 1 - Installation

Introduction
In this chapter you will learn how to install PGSuper. PGSuper can be installed as a stand-alone
application or as an application that shares resources between users on a network. The various
installation options will be discussed in detail.

Quick Start
If you just want to install the darn program now, run the installer and accept the default options. The
program will be installed on your computer along with a non-shared version of the Project Templates and
PGSuper Master Library.
Tip: If you are just evaluating PGSuper, just run the installer and accept the default options. This will get
you running in stand-alone mode in no time. If you decide to adopt PGSuper as a tool in your office, it will
be wise to read this Administrator's Guide carefully so you can make the best use PGSuper's workgroup
features.

Definitions
PGSuper Administrator A person who is responsible for maintaining PGSuper for an entire

office. Responsibilities include maintaining project templates, the
PGSuper library, and customizing PGSuper installations

Project Template A file that contains seed data for a PGSuper project. Seed data
includes bridge configuration, criteria, material properties etc.
Project templates simplify the creation of PGSuper projects

PGSuper Master Library A file that contains frequently used and sometimes very complex
data. Users can simply refer to library entries, such as girder
definitions, by name

Client Someone who uses PGSuper

PGSuper Components
The PGSuper installation consists of four components that can be installed in a variety of ways. The
components are:
PGSuper Program This is the program
PGSuper Project Templates These are the default project templates that

come with PGSuper.
PGSuper Master Library This is the default library that comes with

PGSuper.
PGSuper Administrator Tools These are the tools used by PGSuper

Administrators to manage a PGSuper
installation.
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Types of Installations
PGSuper supports two types of installations; Installation on a network for Workgroups, and Stand-Alone
Installation. Both installation types will install the administrator components and the client components.
Use the table below to help you decide the type of installation you need to perform.

Description Administrator User
You will be working with PGSuper alone. There is no need to share
the project templates and libraries.

A (Optional) C

You work in an office with several bridge engineers. You have
standardized design criteria, bridge configurations, girder types, etc.
You want all the engineers in your office to use the same project
templates and libraries.

B D

Note: Installing PGSuper on Windows NT may require NT Administrator Rights (this is different than
being a PGSuper Administrator)
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Option A - Installing Administrator Tools for Stand
Alone Clients
This installation option is only needed if you plan on creating or editing a PGSuper Master Library file.

1. Start the PGSuper installation program. Accept the default choices until you get to the "Setup
Type" step.

2. Select PGSuper Administrator as the Setup Type.
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3. Select Don't install Bridge Templates
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4. Select Don't Install PGSuper Library for Shared Use

5. Finish the installation by accepting the defaults.
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Option B - Installing Administrator Tools for a
PGSuper Administrator
With this installation option you will install the PGSuper Administrator tools, the default project templates,
and the default PGSuper library.
Note: It is not necessary to use the default project templates and library that come with PGSuper. Using
PGSuper and the Administrator tools, you can create your own templates and libraries. See Chapter 3
and Chapter 4 for more information.

1. Start the PGSuper installation program. Accept the default choices until you get to the "Setup
Type" step.

2. Select PGSuper Administrator as the Setup Type.
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3. Select Install Bridge Templates. This will copy the default WSDOT templates to your hard drive.
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4. Select a location on your network where the shared project templates will be installed. Make sure
this location is accessible to all users.



12

5. Select Install PGSuper Library for Shared Use
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6. Select a location on your network where the PGSuper library file will be installed.

7. Finish the installation by accepting the defaults.

As the PGSuper Administrator, you need to inform your users where the shared project templates and the
shared library are installed so they can enter the correct information when they perform Install Option C.
Note: You can automate Install Option C for your users. Read Automating Client Installations for Network
Clients for details.
Note: Users can change the location where PGSuper looks for shared project templates and the library
file using the File | Program Settings option in PGSuper.
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Option C - Installing PGSuper for Stand Alone Clients
This is the easiest installation. Simply run the installation program and accept all the default responses.
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Option D - Installing PGSuper for Network Clients
For this installation option your PGSuper Administrator must have already completed install Option A.
Before you begin with this installation, get the locations of the shared project templates and the shared
library from your PGSuper Administrator.

1. Start the PGSuper installation program. Accept the default choices until you get to the "Setup
Type" step.

2. Select PGSuper User as the Setup Type.
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3. Select Using Shared Bridge Templates.
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4. Enter the location of the shared templates.
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5. Select Use Shared Copy of the PGSuper Library

6. Enter the name and location of the shared library.

7. Finish the installation by accepting the defaults.
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Automating the Installation for Network Clients
As a PGSuper Administrator, you can make Installation Option D much easier for you users. By passing a
configuration file on the command line of the installer you can specify where the shared project templates
and the shared library reside on your network. Using this option, steps 2 through 6 are eliminated from
Installation Option D.

Preparing the Configuration File
A sample configuration file is installed with Installation Option B. The file is called PGSuperConfig.ini and
its contents are:
[NetUser]
 Templates=J:\PGSuper\Templates
 Library=J:\PGSuper\PGSuper.lbr
Change the value for Templates and Library to reflect the location on your network where the project
templates and library file are installed.

Installing PGSuper
To install PGSuper

1. Select Start | Run
2. Enter PGSuper.exe -a PGSuperConfig.ini in the Open box
3. Press the OK button
4. Accept all the default options in the installer.

You can also create a batch program for your users to run to make the installation easier from their
perspective. The program would simply call the command in Step 2.
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Chapter 2 - Managing the Master Library

Introduction
In order for PGSuper to model real bridge structures and to perform thorough specification compliance
checking, a lot of detailed information is required. The Master Library allows you to create a centralized
storehouse for common PGSuper information that can share in your workgroup. In this chapter you will
learn how to manage the PGSuper Master Library.
In a government organization like WSDOT, you will find standard concrete mixes, standard girder plans,
standard connection details, and the like. While all this information is common, and well documented, it is
still tedious and error-prone to enter into a computer program every time you need to use it.
The PGSuper library greatly simplifies user input. In the various libraries, standard information is recorded
in a library entry and given a common name. When describing the bridge, you simply refer to a library
entry by name. For example, it takes four pieces of data to describe concrete. The detailed data for a
particular concrete entry is given a common name like "8 KSI". To use this concrete in a bridge model,
simply refer to the name "8 KSI". This is a lot easier than entering the 4 input parameters, especially if the
parameters don't change from project to project. "8 KSI" concrete can be defined once and used over and
over again.
The PGSuper Library is comprised of two different types of entries: Master Library Entries and Project
Library Entries. As you might guess, Master Library Entries are stored in the Master Library. The Master
Library is typically stored on a network and all the engineers within an organization can share it. This
makes it easy for an entire team of bridge designers to work with the same information.
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Creating Library Entries
In this section you will learn the basics of editing library entries. The following discussion applies to all of
the PGSuper libraries. The specific parameters for each library entry is given in Appendix B of the
PGSuper User's Guide. To create and edit library entries in the Master Library, you must use the
LibraryEditor program. For more information, see Chapter 4.
Note: The LibraryEditor program is installed with installation option A and B. See Chapter 1 for details.

Creating New Entries
To create a new library entry:

1. Select Library | Add New Entry (ALT,B,A ). This will create a new entry and place an icon in
the library view.

2. See Renaming Entries to give the entry a meaningful name
3. See Editing Entries to edit the library entry parameters.

Copying Entries
It is generally easier to copy an existing entry that it is to create a new one. To copy a library entry:

1. Select the library entry you wish to copy

2. Select Library | Duplicate Entry (ALT,B,U ). A copy of the entry will be made and an icon
placed in the library view.

3. See Renaming Entries to give the entry a meaningful name
4. See Editing Entries to edit the library entry parameters.

Renaming Entries
New library entries and copies of existing entries are given names that aren't very meaningful. To rename
a library entry:

1. Select the library entry you wish to rename
2. Select Library | Rename Entry (ALT,B,E).
3. An editing field will activate next to the entry's icon. Type in the new entry name

Editing Entries
Once you have created or copied an entry, and given it a meaningful name, it is time to edit the input
parameters. To edit a library entry:

1. Select the library entry you wish to edit

2. Select Library | Edit Entry (ALT,B,E ). This will display the entry's editing dialog. Entered the
required information into the dialog. For specific information about an entry's parameters, press
the Help button in the dialog.

3. Press the OK button to commit your changes
Tip: You can edit an entry by double clicking on it.

Deleting Entries
Every now and then, you may want to delete a library entry you no longer need. Only entries in the
Project Library that are not in use can be deleted. Such an entry does not have the lock or check icon.
To delete a library entry:

1. Select the entry you wish to delete

2. Select Library | Delete Entry (ALT,B,D )
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Deploying the Master Library
Once you've created the Master Library using the Library Editor program, you need to deploy it so your
PGSuper Users can access it.
You have two deployment options. The first option is to provide each PGSuper User a copy of the Master
Library file. The second, and preferred option, is to put the Master Library file on a network drive so all
PGSuper users can share the library.
The second option is preferred because it enables you to easily share library data will all of the engineers
in your organization. PGSuper notifies users of changes to the Master Library and can automatically
update their project files. By making changes to a shared Master Library file, all of your PGSuper users
are automatically kept up to date.

Deployment
To deploy the PGSuper master library:

1. Using the techniques outlined in the previous section, create your PGSuper Master Library file.
2. Save or copy the Master Library file to a common folder your computer network that all PGSuper

Users have access to.
3. If you have an installed user base, tell them the location of the PGSuper Master Library file and

how to customize PGSuper to use your Master Library.
Tip: You can customize the PGSuper installation so your Master Library is automatically set for your
users. See Chapter 1 of the PGSuper Administrator's Guide.
Tip: It is a good idea to make a backup copy of your PGSuper Master Library. Access to the library file
should be restricted. You can use your network security options to restrict access.
Note: PGSuper users cannot modify Master Library Entries from PGSuper, but they can from their copy
of the LibraryEditor program.
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Chapter 3 - Project Templates

Introduction
PGSuper creates new projects using the information stored in templates. This has several useful benefits,
the most notable, from the perspective of administration, is establishing defaults that reflect the standard
of practice for your engineering organization.
Generally speaking, PGSuper does not have defaults. Sure, we've supplied PGSuper with templates and
libraries, and these serve as the defaults, but you don't have to use them. In fact, if you don't like our
templates and libraries, you can delete them and create your own.
The project templates that ship with PGSuper, have been created in such a way that when a bridge
designer creates a new PGSuper Project, the project will represent WSDOT's standards of practice. For
example, the WSDOT templates make the methods for computing prestress loss and live load distribution
factors "default" to WSDOT practice. Allowable stress parameters also "default" to WSDOT practice.
In this chapter you will learn how to create and deploy project templates for use in your engineering
organization.

Creating Project Templates
Creating project templates is an easy task. The hard part is coming up with good templates. You will
probably want to consult appropriate bridge design manuals, specifications, and standard plans before
you begin. It is also a good idea seek input from senior bridge designers when creating project templates
that will be used throughout your engineering organization, as these templates reflect your standards of
practice.
To create Project Templates you must use the PGSuper program.
To create a project template:

1. Create a bridge model using the editing techniques described in Chapter 3 and Chapter 4 of the
PGSuper User's Guide.

2. Save the bridge model as a template. Select File | Export to Template File (ALT,F,E).
That's all there is to it.

Deploying Project Templates
After you create your project templates, they must be deployed to your users. There are two ways to
deploy project templates. You can copy them locally onto every user's computer, or you can store them in
one location on your computer network and share them with all your users. In either case, project
templates must be stored in the User Templates Folder or the Workgroup Templates Folder. They can
also be stored in a sub-folder.
The project templates you create (as the PGSuper Administrator) are to be shared amongst the users in
your organization. These are considered Workgroup Project Templates and should be stored in the
Workgroup Templates Folder. Workgroup Templates should be stored in a directory on a network server
that all PGSuper users have access to. By storing project templates on a network server, users
automatically have access to the same information and to any updates that may occur over time.
Note: PGSuper users customize the User Templates Folder and Workgroup Templates Folder settings.
As the PGSuper Administrator, it is your responsibility to provide your users with the location of the
Workgroup Templates Folder. See Chapter 10 of the PGSuper User's Guide for more information.
Tip: You can customize the PGSuper installation so the Workgroup Templates Folder is automatically set
for your users. See Chapter 1 of the PGSuper Administrator's Guide.

Organizing Your Templates
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By storing your templates in sub-folders, you can organize them. The default templates provided with
PGSuper are organized by unit system. Other organizations might include geographical region, span
lengths, or state standards.
All of the templates in the Workgroup Template Folder are presented in the General tab of the New
Projects dialog. Each of the sub-folders corresponds to a tab in the New Projects dialog. The templates in
the sub-folders are displayed on each of these tabs. The figure below illustrates the mapping of the
Workgroup Template Folder and its sub-folders to tabs in the New Project dialog.

Deploying the Templates
To deploy your PGSuper Project Templates:

1. Create a root folder and sub-folders that represent your organization scheme
2. Using PGSuper, and the procedure outlined above, create your project templates.
3. Save the templates into the project template folders
4. If you have an installed user base, tell them the location of the Workgroup project templates and

how to customize PGSuper so their Workgroup Templates setting has the correct setting.



25

Chapter 4 - Library Editor User's Manual

Getting Started
The PGSuper LibraryEditor allows you to add, edit, and remove library entries which can be referenced
from your PGSuper Project files. The following Figure is a typical screen shot of the LibraryEditor in
action.

The primary purpose of the LibraryEditor is to maintain the library file which contains standard library
entries . Most bridge agencies have a fixed list of Girders, Connections, etc. that change very little over
time. Hence, you should not need to change the main library file often once it is set up correctly. We
recommend that you appoint a System Manager to maintain entries in the library and to be very careful
about inputting entries correctly the first time. Most end users will never need to use the LibraryEditor.
All LibraryEditor commands can be accessed through the main menu, and most commonly used
commands can be accessed on the tool bar, or by right clicking your mouse in the list box which displays
the entries.
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Main Menu

File Menu

The File menu offers the following commands:

New Creates a new document.

Open Opens an existing document.

Close Closes an opened document.

Save Saves an opened document using the
same file name.

Save As Saves an opened document to a
specified file name.

Exit Exits LibraryEditor.

New command

Use this command to create a new document in LibraryEditor.

You can open an existing document with the Open command.

Shortcuts

Toolbar: 

Keys: CTRL+N

Open command

Use this command to open an existing document in a new window. You can open
multiple documents at once. Use the Window menu to switch among the multiple open
documents.

You can create new documents with the New command.

Shortcuts

Toolbar: 

Keys: CTRL+O

Close command

Use this command to close all windows containing the active document. LibraryEditor
suggests that you save changes to your document before you close it. If you close a
document without saving, you lose all changes made since the last time you saved it.
Before closing an untitled document, LibraryEditor displays the Save As dialog box and
suggests that you name and save the document.

You can also close a document by using the Close icon on the document's window, as
shown below:
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Save command

Use this command to save the active document to its current name and directory. When
you save a document for the first time, LibraryEditor displays the Save As dialog box so
you can name your document. If you want to change the name and directory of an
existing document before you save it, choose the Save As command.

Shortcuts

Toolbar: 

Keys: CTRL+S

Save As command

Use this command to save and name the active document. LibraryEditor displays the
Save As dialog box so you can name your document.

To save a document with its existing name and directory, use the Save command

Exit command

Use this command to end your LibraryEditor session. You can also use the Close
command on the application Control menu. LibraryEditor prompts you to save
documents with unsaved changes.

Shortcuts

Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



28

Edit Menu
The Edit menu offers the following commands:
Add New Entry Adds a new entry to the library and opens it up for

editing.
Edit Entry Opens the selected entry for editing.
Delete Entry Deletes the selected entry from the library
Duplicate Entry Makes a copy of the selected entry

Add a New Entry to Library
This menu item adds a new entry to the selected library and opens it for editing.

Edit the Selected Library Entry

This command opens up the selected entry for editing.

Shortcuts

Mouse: Double-click on the entry.

Delete the Selected Entry from the Library

Delete the selected entry from the library

Duplicate the Selected Entry

Duplicates the currently selected entry.

Rename The Selected Entry
Rename the selected entry from the library. You must give the entry a unique name.
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Units menu

The Units menu allows you to select whether you would like to input your data in US or
SI units. You may switch between unit systems at any time while using the
LibraryEditor.

Switch to SI Units

Switch to US Units
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Window Menu
The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:
New Window Creates a new window that views the same

document.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.

Cascade command
Use this command to arrange multiple opened windows in an overlapped fashion.

Tile command
Use this command to arrange multiple opened windows in a non-overlapped fashion.



31

View Menu
The View menu offers the following commands:
Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Large Icons Display Library Entries using large icons
Small Icons Display Library Entries using small icons
List Display Library Entries in a plain list
Arrange Icons Arranges icons of closed windows.

Toolbar command
Use this command to display and hide the Toolbar, which includes buttons for some of the most common
commands in LibraryEditor, such as File Open. A checkmark appears next to the menu item when the
Toolbar is displayed.
See Toolbar for help on using the toolbar.

Status Bar command
Use this command to display and hide the Status Bar, which describes the action to be executed by the
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to
the menu item when the Status Bar is displayed.
See Status Bar for help on using the status bar.

Arrange Icons Command
Use this command to arrange the icons for Library Entries.
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Help Menu
The Help menu offers the following commands, which provide you assistance with this application:
Help Topics Offers you an index to topics on which you can

get help.
About Displays the version number of this application.

About command
Use this command to display the copyright notice and version number of your copy of LibraryEditor.
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Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.
The toolbar provides quick mouse access to many tools used in LibraryEditor,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To


Open a new document.

Open an existing document. LibraryEditor displays the Open dialog box, in which
you can locate and open the desired file.

Save the active document or template with its current name. If you have not named
the document, LibraryEditor displays the Save As dialog box.

Add a new entry to the library.

Remove selected entry from the library

Make a duplicate copy of the selected entry.

Edit the Selected entry.

Set the editing units to the SI system.

Set the editing units to the US system.
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Status Bar

The status bar is displayed at the bottom of the LibraryEditor window. To display or hide
the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow
keys to navigate through menus. This area similarly shows messages that describe the
actions of toolbar buttons as you depress them, before releasing them. If after viewing
the description of the toolbar button command you wish not to execute the command,
then release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description

CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.
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Scroll bars
Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars
indicate your vertical and horizontal location in the document. You can use the mouse to scroll to other
parts of the document.
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Title Bar

The title bar is located along the top of a window. It contains the name of the application and document.
To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title bars.
A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button
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